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A
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entation

Thank you for purchasing our GWM-STD/SHG/STD2-000 Laser Scanning System for 
Welding.
Please read this manual carefully to ensure correct use of the product. Keep the 
manual handy after reading for future reference.

1. Organization

This document for the GWM-STD/SHG/STD2-000 Laser Scanning System for Welding 
describes installation, maintenance and system specifications. For instructions for 
welding control using the SWDraw2 application, refer to the manual for SWDraw2.
The documentation comprises the following sections:

• Scanner Controller

Describes the part names, installation, maintenance, and specifications of the 
scanner controller.

• Scanner Head

Describes the part names, installation, maintenance, and specifications of the 
scanner head.

• Warranty
• Address List

2. Note

• Microsoft and Windows are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and other countries.

• Company and product names in this manual are trademarks or registered 
trademarks of their respective owners.

• Unauthorized reproduction of this manual in whole or part is prohibited.
• The contents of this manual are subject to change without notice.
• Every effort has been made to ensure the accuracy of this information. If you come 

across oversights or errors, please notify your dealer.
• Be sure to read the user's manuals for any equipment used in conjunction with the 

system (e.g., documentation for computer systems).

About This Documentation
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3. Symbols Used in this Manual

Indicates instructions that must be followed to prevent hardware or software 
damage or operating errors.

Indicates additional information on a particular topic.

Menus, icons, buttons, 
windows, tabs

Enclosed in brackets.
Example: Click the [OK] button.

Keyboard keys Enclosed in angle brackets.
Example: Press the <Tab> key.

References Enclosed in quotes.
Example: Refer to "Chapter 8-3.2 Changing Passwords" (page 5).

CAUTION

�
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1. Safety Precautions

Read these Safety Precautions thoroughly before use to ensure correct use of the 
system.

• The precaution points indicated here are intended to ensure safe operation of the 
system and prevent hazards or injury to users and other personnel.
They are important details relating to safety and must be read carefully.

• The indications have the following meanings.

Chapter 1 Special Precautions

Indicates that incorrect operation risks death or serious injury to personnel.

Indicates that incorrect operation may result in death or serious injury to 
personnel.

Indicates that incorrect operation may result in injury to personnel or damage to 
property.

Indicates prohibited actions and warns of actions not covered by the product warranty.

Indicates actions that must be performed by users.

The triangular symbol indicates details that supplement DANGER, WARNING, or CAUTION points.

DANGER

WARNING

CAUTION
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Never dismantle, repair, or modify the system. Doing so may result in electric 
shock or fire.
Otherwise there is a risk of electric shock or fire. Do not attempt maintenance other than 
that described in the Operation Manual.

Do not look into or touch the beam.
Direct and scattered laser light is dangerous. Looking directly at the laser source risks 
blindness.

Never burn, destroy, cut, crush or chemically decompose the system.
This product incorporates parts containing gallium arsenide (GaAs).

Wear protective goggles.
Protective goggles must always be worn when using the system.
Care must be taken even when wearing protective goggles, as looking directly at the laser 
source through protective goggles risks blindness. Protective goggles attenuate the laser 
beam, but does not block it.

Never subject parts of the body to laser radiation.
Otherwise there is a risk of burn injuries.

Do not damage power or connector cables.
Do not crush, twist, or pull cables. Damaged cables may result in electric shock, short-
circuiting, or fire.
Contact your dealer or us if repair or replacement is necessary.

Connect securely using the specified cables.
Using cables with inadequate capacity or improper connections may result in fire or 
electric shock.

Connect optical fibers securely.
Improper connection may result in burn injuries or fire.

Stop using the system if a problem arises.
If a problem occurs such as a burning smell, abnormal noise, overheating, or smoke 
emission, continuing to use the system may result in electric shock or fire.
Contact your dealer or us immediately.

Use a stopper.
Laser radiation is hazardous to personnel.When operating the laser during maintenance 
work, use a stopper (light-absorbing/scattering body capable of withstanding high 
temperatures) to prevent laser emission beyond the stopper.

DANGER

WARNING



 1. Safety Precautions

7

GWM-STD/SHG/STD2-000

C
hapter 1

　
Special Precautions

Scanner C
ontroller

Wear protective work clothing.
Wear protective clothing such as gloves, long-sleeved clothing, and a leather apron.
Spatter will cause burn injuries if it lands on the skin.

Keep away from water.
Subjecting electrical components to water may result in electric shock or short-circuiting.

Install in a firm location.
Otherwise there is a risk of injury if the system topples or falls from the installation 
location.

Keep away from flammable materials.
Otherwise there is a risk of fire if spatter created during laser emission lands on 
flammable materials.
If flammable materials cannot be removed from the vicinity, they must be covered with a 
non-flammable cover.

Provide fire extinguishers.
Fire extinguishers must be provided in the welding work area in case of fire.

Inspect and maintain the system periodically.
Inspect and maintain the system periodically, repairing damaged parts and components 
before use.

Do not point the laser beam at flammable materials.
Do not point the laser beam at flammable or combustible materials. Otherwise there is a 
risk of fire.

Keep connector plugs clean and insert fully.
There is a risk of overheating and fire if dust is allowed to accumulate or if plugs are not 
fully inserted.

Hold the plug body when inserting or removing.
There is a risk of damage to the cable and electric shock or fire if the cable is pulled to 
unplug.

Do not cover with blankets or sheets.
Do not cover the system with blankets or sheets while in use. Otherwise there is a risk of 
over-heating and fire.

WARNING

CAUTION
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2. Operating Precautions

(1) A person knowledgeable about laser radiation and laser systems should be 
appointed as a laser safety manager.

The laser safety manager should be responsible for managing the system key 
switches, providing safety instruction to laser operators, and supervising 
operations.

(2) Areas in which lasers are used must be partitioned from other areas by enclosing 
with fences.

These areas should be managed by a supervisor and marked with signs to 
prevent entry by unauthorized personnel.

(3) The system should be used in an ambient temperature range of 5°C to 35°C and 
humidity 80% RH or lower with no sudden temperature fluctuations. Avoid using the 
system in the following locations.
• Locations with dust or oil mist present
• Locations subject to vibration or impact
• Locations in which chemicals are used
• Locations subject to high noise
• Locations susceptible to condensation
• Locations with high concentrations of CO2, NOx, or SOx (The ion-exchange 

resin life may be reduced by exposure to CO2 concentrations of 0.1% or more.)

(4) There is a risk of condensation forming on the lens surface and debris adhering if the 
ambient temperature changes suddenly such as when turning on the heating in cold 
conditions. Avoid sudden temperature fluctuations. There is a likelihood that 
condensation has formed if the output decreases during initial operation. Stop using 
the system immediately, and check the lens surface if there is a likelihood of 
condensation.

(5) The exterior of the system should be wiped clean using a soft or moist cloth. If the 
exterior is particularly dirty, wipe clean using diluted detergent or alcohol.

(6) Do not drop foreign objects such as screws inside the system, as this may result in 
failure of the system.

(7) Operate the system as described in the attached Operation Manual.

(8) Do not turn off the power switch of the scanner controller while a computer is 
connected to the scanner controller.

(9) If a computer is connected, it will continue to access the memory card for about 15 
seconds after going offline. During this time, do not turn off the power switch of the 
scanner controller.

(10) If a computer is connected, never disconnect the USB cable before turning off the 
power switch of the scanner controller.

(11) For more consistent scanning allow the unit to warm up for about 10 to 30 minutes 
after turning it on. The warmup time varies depending on the temperature and 
workpiece material.
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(12) Use only memory cards purchased from us. If commercial cards are used, the unit 
may not function normally.

(13) Before inserting or removing memory cards, always turn off the power switch of the 
scanner controller. If the power switch of the scanner controller is on when cards are 
inserted or removed, data may be lost or the memory card may become unusable.

(14) Back up memory card data regularly. If the memory card data becomes corrupted, it 
may prevent normal scanning or the equipment may not start.

(15) The number of times memory cards are inserted or removed depends on the 
manufacturer’s nominal number of times (10000 times).

(16) When a supervisor or operator enters the area where the laser is used, protective 
measures not to exceed the MPE* level must be taken.

* MPE: The maximum level of permissible exposure of the eyes or skin to laser beams. Abbreviation of 
Maximum Permissible Exposure.

* For other information on managing laser equipment or the MPE level, refer to the 
following standards.
IEC Standards IEC60825-1 “Safety of laser products Part1: Equipment 
Classifications, requirements and use’s guide”

3. For Disposal

This product incorporates parts containing gallium arsenide (GaAs). At the time of 
disposal, separate it from general industrial waste or domestic waste and carry out 
the disposal in accordance with applicable laws and regulations.
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This product is a high-speed spot laser welding system which uses a digital scanner in 
the emitter for laser light sent via optical fiber.
It can be combined with ML Series laser welders to achieve consistent, high-quality, 
high-speed multi-spot welding.
In addition to high-speed schedule-switching and waveform control functions that are 
the feature of feedback lasers, the system features a galvanoscanner optical system 
allowing high-precision, high-speed beam scanning. This enables high-quality, 
consistent, high-speed welding for multi-parameter welding on different materials 
within the same workpiece as well as multi-spot welding for identical materials.

• Consistent, high-speed multi-spot welding

Achieves maximum laser repeat speed of 227 pps (0.4 ms pulse width, 1 mm 
movement interval, 100 mm dia. machining area lens). However, cannot be used 
exceeding the maximum ratings of the laser welder.

• Consistent, high-speed seam welding

Achieves maximum laser repeat speed of 5000 pps (*1) or CW high-speed seam 
welding. However, cannot be used exceeding the maximum ratings of the laser 
welder.
*1: As of May 2009. This value depends on the capability of the laser welder connected.

• Consistent, high-speed multi-parameter spot welding

The power feedback laser system (waveform control function and high-speed 
schedule switching function) facilitates multi-parameter spot welding for different 
materials and thicknesses within the same workpiece.

• High-precision beam scanning function

The digital scanner improves scanner performance such as reduction of 
temperature drift, and precision of repetition position.

• System configuration to suit customer requirements

Can be combined with the ML Series laser welder to create a system able to cope 
with fine welding or high-output applications such as copper welding.

• Multiscanner welding

GWM-STD/SHG can control up to 3 scanner heads simultaneously. (GWM-STD2-
000 can control only one scanner.)

Chapter 2 Features
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1. Overall Configuration

Chapter 3 System Configuration
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2. Name and Functions of Each Section

2.1. Front

(1) LASER CONTROL button

Switches the control method.
Turn ON to control the equipment by the scanner controller.
Turn OFF to operate the laser welder independently.

(2) Memory card slot

For loading and saving scanning data.
Insert a memory card to prepare the scanner controller for use.

(3) Access indicator

Remains lit during memory card access.

(4) Panel indicators

Panel indicators light in accordance with the status of the equipment as follows:

Always turn OFF the power switch before inserting or removing memory cards.
If the power switch is on when cards are inserted or removed, data may be lost or 
the memory card may be rendered unusable.
We recommend backing up your data at periodic intervals to prevent data loss.
(Refer to  "Chapter 10-3. Backup Lithium Battery Replacement" (page 61) .)
Use only the specified memory cards.
Use of non-specified commercial cards may result in aberrant function.

Do not turn OFF the power switch when the access indicator is lit.
Turning OFF the power switch when the indicator is lit may result in data loss or 
unreadable memory cards.

POWER The equipment is ON.
READY LD (HV) is ON in the laser welder and the equipment is ready to scan.
SHUTTER The resonator shutter in the laser welder is open.

CAUTION

CAUTION
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For external communications.

(6) EXT. I/O (1) to (4)-USER connector

Connector for I/O signals to control the scanner controller from an external 
device.

2.2. Rear

(1) HEAD1 to 3 I/F connector

For connection to the scanner head using the head control external cable.
Insert the head shorting connector for the unused connector.

(2) EXT. I/O (3)-LASER connector

Connector for I/O signals to control the laser welder from the scanner controller.
Connect to the EXT. I/O (3) connector of the laser welder using the EXT. I/O (3)-
LASER cable.

(3) SCANNER1 to 3 connector

For connection to the scanner head using the scanner cable.

LASER Scanning underway.
GUIDE The guide beam is ON.
TROUBLE An error occurred.

GWM-STD/SHG

GWM-STD2-000
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(4) USB connector

For communications with a computer.
Used to send data to/receive data from a computer.
Connect to a computer using the USB cable.

(5) POD connector

For communications with the laser welder.
Connect to the RS-485 (1) connector of the laser welder using the RS-485 cable.

(6) EXT. I/O (1)/(2)-LASER connector

Connector for I/O signals to control the laser welder from the scanner controller.
Connect to the EXT. I/O (1)/(2) connector of the laser welder using the EXT. I/O 
(1)/(2)-LASER cable.

(7) Power switch

Turn ON to supply power.
Turn OFF to cut the power supply and stop the equipment.

(8) Power supply connector

For connection to the power cable.

(9) AXIS. I/O connector

Connector for I/O signals of the carriage control.
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1. Unpacking

1.1. Lifting and Transporting Container

1.2. Checking the Contents of Container

Verify that contents of the container agree with the following list.

Chapter 4 Installation

When moving the container, use a cart or ensure at least two people carry it.

Dimension Mass 
(including contents)

Container for scanner 
controller and 
accessories

Approx. 661 (H) x 601 (W) x 494 (D) mm Approx. 8 kg

Component Quantity

Scanner controller 1

EXT. I/O (1)-LASER cable 1

EXT. I/O (2)-LASER cable 1

EXT. I/O (3)-LASER cable 1

RS-485 cable 1

Head control external cable 1 (× Number of branches)

Scanner cable 1 (× Number of branches)

USB cable 1

Power cable 1

Operation manual for GWM series CD-ROM 1

Operation manual for SWDraw2 CD-ROM 1

PC software SWDraw2 1

Head shorting connector 2

CAUTION
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2. Installation

2.1. Installation Requirements

Refer to the following figure when determining a location to install the scanner 
controller. For more efficient cooling, choose a location where it is not too close to the 
walls.
Additionally, make sure the front of the equipment is easily accessible.

2.2. Connections

The software driver must be installed before connecting a computer to the scanner 
controller. Refer to the manual for SWDraw2 for instructions on installing the driver.

2.3. Ground Connection

Be sure to ground the power cable.

Required Clearance and Mass Support

A. Clearance on top At least 300 mm

B. Clearance on both sides At least 300 mm

C. Clearance in back At least 300 mm

D. Mass Approx. 6.9 kg

Air intake/exhaust Left side/right side

（Front）（Back）

B

B

C

A

（Front）（Back）

（Bottom）

（Top)

D
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1. Starting the Equipment

Before startup, confirm the following points.

• The laser welder, scanner controller, and computer are off.
• The laser welder, scanner controller, and computer are connected with the USB cable.
• A memory card is correctly inserted in the scanner controller.

1 Turn on the laser welder.

2 Turn on the laser welder Control key 
switch.

3 Once the laser welder is charged, 
"READY!!" is displayed on the operating 
panel for 0.5 seconds, after which the last 
screen displayed before shutdown 
appears.

4 Turn on the scanner controller. All panel 
indicators are lit and self-diagnosis 
begins.

5 After self-diagnosis is complete, the 
Power indicator alone should remain lit. 
After confirming it is lit, go to the next 
step.

Chapter 5 Starting/Stopping the 
Equipment

Before starting SWDraw2, exit all 
other applications.

The Access indicator is lit while self-
diagnosis is being performed or 
data is being saved. Do not remove 
memory cards or turn off the power 
switch when the Access indicator is 
lit. Otherwise, the data may become 
corrupted and the memory card 
may become unusable.

CAUTION

CAUTION
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6 Start the computer.
After confirming that the computer is 
running, go to the next step.

7 Double-click the [SWDraw2] icon on the 
desktop to start the SWDraw2 
application.
After SWDraw2 starts, the Drawing 
screen is displayed.

8 Confirm that the equipment is connected 
correctly by checking the status display 
field on the Drawing screen.
"Online" displayed in the title bar 
indicates that the scanner controller is 
online.

Equipment startup is now complete.
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2. Stopping the Equipment

1 From the menu, select [Laser Control]
-> [Control].
The [Control] screen appears.

2 When [HV] or [LD] appears as [ON], click 
the [HV OFF] or [LD OFF] button.

3 The READY indicator on the scanner 
controller flashes and the "Cooling down" 
message is displayed on the Drawing 
screen while operation is stopped. The 
length of time for which the READY 
indicator flashes depends on the laser 
welder current. (Maximum: 300 seconds.)

4 The READY indicator on the scanner 
controller will go out after the HV or LD 
has finished shutting down. The "Cooling 
down" message disappears on the 
Drawing screen.

Do not turn off the power switch while 
the READY indicator on the scanner 
controller is flashing or the Drawing 
screen displays the "Cooling down" 
message.
Shutting off the power switch while 
the system is stopped will 
significantly reduce the life of the 
laser welder.

Do not shut off the power while 
"Online" is displayed in the title bar. 
Shutting off the power switch while 
[Online] is displayed may result in the 
loss of data on memory card, 
preventing the system from 
restarting.

[HV OFF]* button

* The screen shown above is for ML-2450A. For ML-6****, [HV]
  and [HV OFF] are displayed as [LD] and [LD OFF], respectively.

CAUTION

CAUTION
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5 Click the [Offline] button on the [Control] 
screen.

6 Click the [Close] button to close the 
[Control] screen.

7 To exit SWDraw2, select [File] -> [Exit] 
from the menu or click the Close box ([x] 
button) in the top-right corner of the 
screen.

8 Exit Windows by selecting [Turn Off 
Computer] from the Start menu, and then 
turn off the computer.

9 Turn off the power of scanner controller.

10 Turn off the laser welder Control key 
switch.

11 Turn off the laser welder.

System shutdown is now complete.

[Offline] button

[Close] button

Close box ([x] button)
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1. Pin Layout

1.1. External Input and Output (EXT. I/O (1)-USER)

Connector for Unit: D-Sub 37 Pins, Female
Connector for User Device: D-Sub 37 Pins, Male M2.6

Chapter 6 Interface

Ready (out)

LD/HV ON (out)

Trouble (out)

Monitor end (out)

Monitor normal (out)

Monitor trouble (out)

External input receivable (out)

Lamp power upper limit / Laser output (out)

Scanning in progress (out)

Ready to scan (out)

Output COM

Output COM

0 V OUT

+24 V OUT

External signal source IN

External signal COM

LD(HV)-ON/OFF (in)

Error reset (in)

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

(in) Scan start

(in) Scan stop

(in) Guide beam ON/OFF

(in) Control switching

(in) Beam select 1

(in) Beam select 2

(in) Beam select 3

Input COM

Input COM

Input COM

Input COM
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1.1.1. Input signals

*1: This signal is enabled when "Remote" is selected on the PC operating screen or the Control 
switching input on the EXT. I/O (1)-USER. It is disabled when "Local" is selected.

Pin No. Signal Description

16 External signal source IN
Input terminal for the external signal power 
supply. Connect it to Pin 14 or Pin 15, depending 
on the input signal circuit. Input 24V DC.

17 External signal COM
Common input terminal for external signals. 
Connect it to Pin 15 or Pin 14, depending on the 
input signal circuit.

18 LD(HV)-ON/OFF
When this Pin 18-COM circuit is closed, the LD or 
high voltage is turned on. When the circuit is 
opened, the LD or high voltage is turned off.

19 Error reset
(Trouble reset) Close input cancels the trouble output.

20
Scan start

(Laser start) *1
Laser is output when closed.

21
Scan stop

(Laser stop) *1
Laser output is stopped when closed.

22 Guide beam ON/OFF Guide beam turns on at rising edge of closing and 
turns off at falling edge of opening.

23 Control switching
While this Pin 23-COM circuit is closed, the 
remote mode is set and the external input signals 
are effective.

24 Unused Do not connect anything.

25 Beam select 1
When this Pin 25-COM circuit is closed, laser 
beam input unit 1 is selected and the unit 
becomes ready to project a laser beam.

26 Beam select 2
When this Pin 26-COM circuit is closed, laser 
beam input unit 2 is selected and the unit 
becomes ready to project a laser beam.

27 Beam select 3
When this Pin 27-COM circuit is closed, laser 
beam input unit 3 is selected and the unit 
becomes ready to project a laser beam.

28 Unused Do not connect anything.

29 Unused Do not connect anything.

30 Unused Do not connect anything.

31 Unused Do not connect anything.

32 Unused Do not connect anything.

33 Unused Do not connect anything.

34 Input COM Common terminal for input signals.

35 Input COM Common terminal for input signals.

36 Input COM Common terminal for input signals.

37 Input COM Common terminal for input signals.
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1.1.2. Output signals

Output format : Open collector output
Output rating : 24 V DC, 70 mA max

*1 This signal is open during scanning and when writing data to the memory card.
*2 For ML-6040A/6700B/6810B, the closing time is 20 ms.

Pin No. Signal Description

1 Ready
When the LD or high voltage is turned on and the 
laser is ready to output, this Pin 1-COM circuit is 
closed internally.

2 LD(HV) ON While the LD or high voltage is supplied, this Pin 
2-COM circuit is closed internally.

3 Trouble If trouble arises, this Pin 3-COM circuit is opened 
internally until it is reset.

4 Monitor end*2
After the laser is output, this Pin 4-COM circuit 
is closed internally for 40 ms. This is the same as 
the end signal of the laser welder.

5 Monitor normal*2
When the monitor value of laser energy is in the 
range of "HIGH" and "LOW" set on the 
MONITOR screen, the circuit is closed for 40 ms.

6 Monitor trouble*2
When the monitor value of laser energy is out of 
the range of "HIGH" and "LOW" set on the 
MONITOR screen, the circuit is closed for 40 ms.

7 Unused Do not connect anything.

8 External input receivable

When an external input signal is acceptable 
(when the section between Pin 23 and COM is in 
a closed circuit), the circuit is closed. In the open 
circuit status, an external input signal is not 
acceptable if it is input.

9

(For YAG (SHG) laser 
welders)

Lamp power upper limit

When the lamp input power exceeds the value set 
in "REFERENCE SETTING", the circuit is 
closed.

(For Fiber laser welders)

Laser output (for indicator)

While the laser is output, this pin is closed 
internally.
This is a signal for turning on an indicator during 
laser output. Do not use for timing control.

10 Scanning in progress Closed during scanning.

11 Ready to scan*1 Closed when scanning is possible.

12 Output COM Common terminal for output signals.

13 Output COM Common terminal for output signals.

14 0V OUT Power supply for output signals.
Do not use it for any other purpose.

15 +24V OUT Power supply for input signals.
Do not use it for any other purpose.
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1.2. External Input and Output (EXT. I/O (2)-USER)

Connector for Unit: D-Sub 25 Pins, Female
Connector for User Device: D-Sub 25 Pins, Male M2.6

1.2.1. Input signals

Pin No. Signal Description

15 Unused Do not connect anything.

16 Unused Do not connect anything.

17 Timesharing unit 1

When the section between this pin and COM is 
put in a closed circuit, timesharing unit 1 is 
operated so that laser light can be output from 
input unit 1.

18 Timesharing unit 2

When the section between this pin and COM is 
put in a closed circuit, timesharing unit 2 is 
operated so that laser light can be output from 
input unit 2.

19 Unused Do not connect anything.

20 Unused Do not connect anything.

21 Unused Do not connect anything.

22 Unused Do not connect anything.

23 Unused Do not connect anything.

24 Unused Do not connect anything.

25 Unused Do not connect anything.

Resonator shutter open (out)

Branch shutter 1 open (out)

Branch shutter 2 open (out)

Branch shutter 3 open (out)

Timesharing unit 1 ON (out)

Timesharing unit 2 ON (out)

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

(in) Timesharing unit 1

(in) Timesharing unit 2



 1. Pin Layout

25

GWM-STD/SHG/STD2-000

C
hapter 6

　
Interface

Scanner C
ontroller

1.2.2. Output signals

Output format : Open collector output
Output rating : 24 V DC, 70 mA max

Pin No. Signal Description

1 Resonator shutter open
(Main shutter open)

When the resonator shutter is open, this Pin 1-
COM circuit closes internally. This is unused 
depending on the laser welder model.

2 Branch shutter 1 open While branch shutter 1 is open, this Pin 2-COM 
circuit closes internally.

3 Branch shutter 2 open While branch shutter 2 is open, this Pin 3-COM 
circuit closes internally.

4 Branch shutter 3 open While branch shutter 3 is open, this Pin 4-COM 
circuit closes internally.

5 Unused Do not connect anything.

6 Unused Do not connect anything.

7 Unused Do not connect anything.

8 Timesharing unit 1 ON While timesharing unit 1 is operated, this Pin 8-
COM circuit closes internally.

9 Timesharing unit 2 ON While timesharing unit 2 is operated, this Pin 9-
COM circuit closes internally.

10 Unused Do not connect anything.

11 Unused Do not connect anything.

12 Unused Do not connect anything.

13 Unused Do not connect anything.

14 Unused Do not connect anything.
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1.3. External Input and Output (EXT. I/O (3)-USER)

Connector for Unit: D-Sub 9 Pins, Female
Connector for User Device: D-Sub 9 Pins, Male M2.6

1.3.1. Input signals

1.3.2. Output signals

Output format : Open collector output
Output rating : 24 V DC, 70 mA max

*1 When the equipment is not equipped with the emergency stop output signal, the emergency stop 
output signal is invalid.

Pin No. Signal Description

2 Emergency stop input

Open input stops laser output and switches to 
LD(HV)-OFF.
When scanning is performed with a computer, this is 
needed to be closed.

7 Emergency stop input

Open input stops laser output and switches to 
LD(HV)-OFF.
When scanning is performed with a computer, this is 
needed to be closed.

Pin No. Signal Description

1
Emergency stop 

output*1
Opened at emergency stop.

6
Emergency stop 

output*1
Opened at emergency stop.

Emergency stop output (out)

Emergency stop input (in)

1

2

3

4

5

6

7

8

9

(out) Emergency stop output

(in) Emergency stop input
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1.4. Extended External Input and Output (EXT. I/O (4)-USER)

Connector for Unit: D-Sub 15 Pins, Female
Connector for User Device: D-Sub 15 Pins, Male M2.6

1.4.1. Input signals

Pin No. Signal Description

2

Layout no. selection

Layout number selection input (binary code 1)

3 Layout number selection input (binary code 2)

4 Layout number selection input (binary code 4)

5 Layout number selection input (binary code 8)

6 Layout number selection input (binary code 16)

7 Layout number selection input (binary code 32)

8 Layout number selection input (binary code 64)

9 Layout number selection input (binary code 128)

10 Layout number selection input (binary code 256)

11 Layout number selection input (binary code 512)

12 Layout no. 
confirmation strobe When closed, the layout number is confirmed.

13 Input COM Common terminal for input signals.

+24 V OUT

Layout no. selection BC 1 (in)

Layout no. selection BC 2 (in)

Layout no. selection BC 4 (in)

Layout no. selection BC 8 (in)

Layout no. selection BC 16 (in)

Layout no. selection BC 32 (in)

Layout no. selection BC 64 (in)

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

(in) Layout no. selection BC 128

(in) Layout no. selection BC 256

(in) Layout no. selection BC 512

(in) Layout no. confirmation strobe

(in) Input COM

(out) Layout no. confirmation

0 V OUT
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1.4.2. Output signals

Pin No. Signal Description

1 +24 V OUT Power supply for input signals.
Do not use it for any other purpose.

14 Layout no. 
confirmation

Close (ON) output is supplied with the layout 
number confirmation.

15 0 V OUT Power supply for output signals.
Do not use it for any other purpose.
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1.5. Carriage Control Input and Output (AXIS. I/O)

Connector for Unit: D-Sub 25 Pins, Male
Connector for User Device: D-Sub 25 Pins, Female M2.6

1.5.1. Input signals

Pin No. Signal Description

1 +24 V OUT Power supply for external I/O.

2 Unused Do not connect anything.

3 Unused Do not connect anything.

4 Unused Do not connect anything.

5 Unused Do not connect anything.

6 Unused Do not connect anything.

7 Unused Do not connect anything.

8 Operation complete input 
ACK

The carriage control operation is checked to 
resume the scanning operation.

9 Unused Do not connect anything.

10 DI common Common terminal for input signals.

19 0 V OUT Ground for +24 V DC output.

20 Unused Do not connect anything.

24 Unused Do not connect anything.

25 Unused Do not connect anything.

+24 V OUT

Operation complete input ACK (in)

DI common (in)

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

(out) Strobe

0 V OUT

(out) DO common
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1.5.2. Output signals

Pin No. Signal Description

11 Unused Do not connect anything.

12 Unused Do not connect anything.

13 Unused Do not connect anything.

14 Unused Do not connect anything.

15 Unused Do not connect anything.

16 Strobe Turned ON when the carriage control operation is 
permitted.

17 Unused Do not connect anything.

18 Unused Do not connect anything.

21 DO common Common terminal for output signals.

22 Unused Do not connect anything.

23 Unused Do not connect anything.
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2. Example Connection

2.1. External Input and Output (EXT. I/O (1)-USER, EXT. I/O (2)-USER)

2.1.1. When external inputs are contacts

TLP180

Inside of the controller　　　  EXT.I/O(1)-USER connector

*+24V 100mA max.
Do not use this power 
supply in any case 
except for input signals.

10k

10k

10k

10k

10k

10k

10k

10k

24V DC

EXT.I/O(2)-USER connector

１４
１５
１６
１７
１８
１９
２０
２１
２２
２３
２４
２５
２６
２７
２８
２９
３０
３１
３２
３３
３４
３５
３６
３７

１５
１６
１７
１８
１９
２０
２１
２２
２３
２４
２５

D-Sub 37pin

D-Sub 25pin

0V output
+24V output
External signal power supply
External signal COM
LD(HV)-ON/OFF
Error  reset
Scan start
Scan stop * Normally closed

Guide beam ON/OFF
Control switching

Beam select 1
Beam select 2
Beam select 3

Input COM
Input COM
Input COM
Input COM

Timesharing unit 1
Timesharing unit 2

TLP180

TLP180

TLP180
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2.1.2. When external inputs are NPN transistors

2.1.3. When external inputs are PNP transistors

2.1.4. When external power source is supplied

10k

10k

24V DC

１４
１５
１６
１７
１８

３１
３２
３３
３４

0V OUT
+24V OUT
External signal source
External signal COM

Input COM

10k

10k

TLP180

TLP180

TLP180

TLP180

10k

10k

24V DC

１４
１５
１６
１７
１８

３１
３２
３３
３４

10k

10k

0V OUT
+24V OUT
External signal source
External signal COM

Input COM

TLP180

TLP180

10k

10k

24V DC
１４
１５
１６
１７
１８

３１
３２
３３
３４

10k

10k

24V DC
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2.1.5. Example connection of external output signals

TLP197G

Inside of the controller   EXT.I/O(1)-USER connector

EXT.I/O(2)-USER connector

１
２
３
４
５
６
７
８
９
１０
１１
１２
１３

１
２
３
４
５
６
７
８
９
１０
１１
１２
１３
１４

D-Sub 37pin

D-Sub 25pin

Ready
LD(HV) ON
Trouble
Monitor end (END)
Monitor normal (NORMAL)
Monitor trouble (LOW･HIGH)

External input receivable

Scanning in progress
Ready to scan
Output COM
Output COM

Resonator shutter open
Branch shutter 1 open
Branch shutter 2 open
Branch shutter 3 open

Timesharing unit 1 ON
Timesharing unit 2 ON

24V DC

RY

RY

RY

*

*

TLP197G

TLP197G

TLP197G

TLP197G

* The porality may be 
   positive or negative.

Type of output: Photo MOS relay output
Rating of output: 24V DC, 20mA max.
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2.2. External Input and Output (EXT. I/O (3)-USER)

RY

EXT.I/O(3)-USER connector

Inside of the controller +24V 7

2
Emergency stop
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2.3. Extended External Input and Output (EXT. I/O (4)-USER)

2.3.1. When connected to 24 V DC source output PLC
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2.3.2. When using contact signal
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2.3.3. When using open collector signal
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3. Timing

3.1. During Normal Operations (Single Delivery)

*1 Layout no. input setting range: 1 to 1023. Treated as 1 if set to 0.
*2 Layout no. is confirmed at rising edge of Layout no. confirmation input. Layout no. confirmation 

input is enabled while startup ready output is on and laser outputting output is off.
*3 The control switching can be set from a computer or the Control switching input on the EXT. I/O (1)-

USER.
*4 The laser output indicates the equipment status. Other signals indicate the I/O signals.
*5 The ready output becomes off when the ready to scan output is off.
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3.2. During Normal Operations (2-timesharing Delivery)

*1 Layout no. input setting range: 1 to 1023. Treated as 1 if set to 0.
*2 Layout no. is confirmed at rising edge of Layout no. confirmation input. Layout no. confirmation 

input is enabled while startup ready output is on and laser outputting output is off.
*3 The control switching can be set from a computer or the Control switching input on the EXT. I/O (1)-

USER.
*4 The laser output indicates the equipment status. Other signals indicate the I/O signals.
*5 The ready output becomes off when the ready to scan output is off.
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3.3. During Data Errors (Errors from Unregistered Layouts)

*1 The unregistered layout error occurs when the layout no. confirmation is not output even one second 
after the layout no. confirmation strobe input.

*2 The laser output indicates the equipment status. Other signals indicate the I/O signals.
*3 The ready output becomes off when the ready to scan output is off.
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4. RS-232C Communication Functions

4.1. Overview

You can transfer data to the scanner controller via serial communications, as well as 
setting and reading scanning schedules from a connected computer.
Data communicated via serial ports is sent and received bit by bit (sequentially) over 
two separate lines.

4.2. Interface

(1) Cable specifications
The specifications for the connecting cable are given below.

•  D-Sub 9 pins, female
•  UNC is used for nos. 4-40
•  Cross-connected
•  A shield line included
•  Maximum length: 10 m

The pin assignments are given below.

Pin Signal Description

1 - -

2 RXD Receive Data

3 TXD Transmit Data

4 DTR Data Terminal Ready

5 SG Signal Ground

6 DSR Data Set Ready

Connection example: Connected to a computer

Controller Computer
Shield lineSignal Pin No. Signal

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

RXD
TXD
DTR
SG

DSR
RTS
CTS

RXD
TXD
DTR
SG

DSR
RTS
CTS

FG Case 

Pin No.
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(2) Communication settings

Communication settings specifics are given below.

*1 Asynchronous communications involve interspersing control signals with the individual 
characters being sent. Specifically, the “start bit” and “stop bit” (indicating the start and end of 
the character, respectively) are added. If there is no data to send, only the stop bit signal will be 
sent. To receive data, the receiving side repeatedly acknowledges readiness to receive the next 
character after detecting a start bit.

*2 Parity check: parity-based error detection method. A single parity bit, 0 or 1 for binary data, 
indicates whether the amount of data is even or odd.

*3 Baud rate: communications rate. The volume of data transmitted per second in bits is given in 
bps.

*4 Flow control: control used to manage halting and resumption of data transmission between 
devices exchanging data.

*5 Checksum: error detection method for received data. Data totals are calculated and transmitted 
with data; the totals are calculated once again on the receiving side and compared to the 
transmitted totals. Sums that fail to match indicate an error.

7 RTS Request To Send

8 CTS Clear To Send

9 - -

－ FG Frame Ground: safety ground or cable shield

Use a connecting cable with a shield line.
Make sure that the case you connect to is designed to resist 
electromagnetic interference (EMI).

Item Value

Electrical interface Conforms to the RS-232C specification

Method Asynchronous*1

Data bit length 8 bits

Stop bit length 1 bit

Parity check*2 Even

Baud rate*3 9600 bps

Flow control*4 No

Checksum*5 OFF

Delimiter ETX OFF

Pin Signal Description

�



 4. RS-232C Communication Functions

43

GWM-STD/SHG/STD2-000

C
hapter 6

　
Interface

Scanner C
ontroller

4.3. Instructions for RS-232C Communications

RS-232C communications with the scanner controller involve exchange of ASCII data.
Up to 2048 bytes may be sent or received at a time, including STX and ETX.
If a transmission error occurs (parity errors, for example), the data is discarded.
Only after successful reception up to the point of ETX will an ACK, NAK, or the usual 
data be returned.

4.4. Communications Protocol

In RS-232C communications with the scanner controller, data basically consists of the 
following elements:

(1) Transmission control code

The transmission control codes are as follows:

Name Value Details

STX 0x02 Start transmission

ETX 0x03 End transmission

ACK 0x06 Acknowledge successful reception

NAK 0x15 Negative acknowledgment; processing errors occurred 
during reception

Conditions under which a NAK is returned:

•  Incorrect checksum
•  Specified command does not exist.
•  Specified value exceeds the setting range.
•  Insufficient internal RAM
•  Specified command cannot be executed at this time

 (for example, if a command is issued to begin scanning when scanning is not 
possible).

S
T
X

Command
2046 bytes

or less

E
T
X

Controller

Check-
sumComputer

S
T
X

Command
2046 bytes 

or less

E
T
X

A
C
K

N
A
K

or or Check-
sum

STX
Command Segment
Response Segment

(0-2046 bytes)

Checksum
(2 bytes)

(Only when 
selected)

ETX
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(2) Numerical notation
• Signs

• Values

The value itself is expressed as a decimal number unless otherwise specified.

• Data with decimals

(3) String notation

* Commas are generally not expressed since commas are special characters used as delimiters. To 
indicate a comma used as a comma, add the special character “\” before the character.
Characters after “\” are not treated as delimiters. Use “\,” to designate a comma. To express “\,” 
use “\\”.

* Strings can be up to 40 bytes unless otherwise specified.

Plus Nothing is added before the number.

Minus 0x2D is added before the character.
Hexadecimal notation itself does not indicate the sign of a value.

Decimal numbers Available ASCII codes are from 0x30 to 0x39.

Hexadecimal numbers
(in the checksum 
segment)

A value from 0x41 to 0x46 is added to the ASCII code 
available for the decimal numbers.
Lowercase letters cannot be used.

Examples of numerical notation

ASCII code
(symbols and 
alphanumeric)

Single-byte code from 0x20 to 0x7F

Single-byte 
katakana

Single-byte code from 0xA1 to 0xDF

Kanji Double-byte Shift-JIS code starting with a code from 0x80 to 
0x9F or from 0xE0 to 0xFF

Example of string notation

The decimal number "1": .......................................................... 0x31
The decimal number "-1": ......................................................... 0x2D, 0x31
The hexadecimal number "FFA0": ............................................ 0x46, 0x46, 0x41, 0x30
The axial rotation angle is "45.000000°": .................................. 45000000

0x31, 0x32, 0x33, 0x34, 0x35, 0xB1, 0xB2, 0xB3, 0xB4, 
0xB5  (10 bytes) 

12345 ................

ABC ................... 0x8A, 0xBF, 0x8E, 0x9A, 0x41, 0x42, 0x43 (7 bytes)
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4.5. Commands

The commands are listed below.
The beginning of a command segment signify specific command itself.

4.5.1. Command Details

(1) RTR/RTW (Axial rotation angle)

Read/Write the axial rotation angle at which all layout data is rotated.
The setting increment is 0.000001°.

Command Function details

Read Write Parameter Setting increment/details

RTR RTW

X and Y axes

Axial rotation angle 0.000001°

XOR XOW X-axis offset 1 µm

YOR YOW Y-axis offset 1 µm

XYR XYW
X-axis offset
Y-axis offset
Axial rotation angle

1 µm
1 µm
0.000001°

LMR LMW

Laser control

Laser start 0: OFF
1: ON

MSR MSW Scanning start 0: End
1: Scanning in progress

TSR TSW Test scanning start 0: End
1: Test scanning in progress

GLR GLW Guide beam 0: OFF
1: ON

LNR LNW Layout number 
selection Layout number

RLR RLW Toggle external control 0: Local (internal)
1: Remote (external)

DSR DSW Opening/closing branch 
shutters

0: Closing branch shutter
1: Opening branch shutter

MRR MRW Scanning 
data Scanning data Layout number

ERR

Maintenance

Reset errors

TRB Error code acquisition

WSR WSW Scanner warm-up 
execution

WWWR00 Lase power 
monitor 
control

Power monitor data 
acquisition

WWWR95 Power monitor count 
acquisition
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(2) XOR/XOW (X-axis offset)

Read/Write the X-axis offset for all the layout data.
The setting increment is 1 µm.

(3) YOR/YOW (Y-axis offset)

Read/Write the Y-axis offset for all layout data.
The setting increment is 1 µm.

(4) XYR/XYW (X-axis offset, Y-axis offset, Axial rotation angle)

Read/Write the X-axis offset, Y-axis offset and axial rotation angle for all layout 
data.

 Write (XYW t0, t1, t2)
t0: X-axis offset (unit: 1 µm)
t1: Y-axis offset (unit: 1 µm)
t2: Axial rotation angle (unit: 0.000001°)

(5) LMR/LMW (Laser start)

Read/Write the LD/HV activation status.
In this setting, 0 = OFF and 1 = ON.

(6) MSR/MSW (Scanning start), TSR/TSW (Test scanning start)

Read/Write the scanning status.
In the read setting, 0 = Finished and 1 = Scanning in progress.
In the write setting, 0 = Stop scanning and 1 = Start scanning.
Writing 1 (to start scanning) is valid only under local (internal) control. Writing 0 
(to stop scanning) is valid under both local and remote control.

(7) GLR/GLW (Guide beam)

Read/Write the guide beam activation status.
In this setting, 0 = OFF and 1 = ON.

(8) LNR/LNW (Layout number selection)

Read the currently selected layout number.
Also used to change the layout number by writing the specified layout number 
instead.

(9) RLR/RLW (Toggle external control)

Obtain the current status of the device used for external control.
Also used to switch the control method.
In this setting, 0 = Local (Internal) and 1 = Remote (External).

Local The layout number can be set and scanning initiated from the touch 
panel, computer, or device connected via RS-232C.

Remote The layout number can be set and scanning initiated with an external I/O 
signal.
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(10) DSR*/DSW (Opening/closing branch shutter)
* The DSR command is valid for the controller version V00-05E or later.

Read/Write the status of branch shutter.

 Read (DSR)

 Write (DSW t0, t1)
t0: Branch shutter No. (1 to 6)
t1: Opening/closing status (0: Closing, 1: opening)

(11) MRR/MRW (Scanning data)

Obtain (read) the value of the existing layout number and specified line or 
change (write) the settings.

■ Read array data (MRR s0, 1, 5, s3)
s0: Layout number
s3: Array no. (More than one can be specified)

Computer -> Controller : DSR

Controller -> Computer : S0, S1, S2, S3, S4, S5

S0 Branch shutter 1 status 0: Closed 1: Open
S1 Branch shutter 2 status 0: Closed 1: Open
S2 Branch shutter 3 status 0: Closed 1: Open
S3 Branch shutter 4 status 0: Closed 1: Open
S2 Branch shutter 5 status 0: Closed 1: Open
S3 Branch shutter 6 status 0: Closed 1: Open

Example

When obtaining the value of layout #1 and arrays 1, 2, and 10
Computer -> Controller : MRR1, 1, 5, 1, 2, 10

Controller -> Computer : 10000,0,45000001,20000,0,0,20000,20000,0
Matrix No. 1:
X offset 10.000mm, Y offset 0.000mm, Axis rotation angle 
45.000001°
Matrix No. 2:
X offset 20.000mm, Y offset 0.000mm, Axis rotation angle 
0.000000°
Matrix No. 10:
X offset 20.000mm, Y offset 20.000mm, Axis rotation 
angle 0.000000°
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■ Write array data (MRW t0,1,5,t3,t4,t5,t6)
t0: Layout number
t3: Matrix number (0 to 9999)
t4: X offset (unit: µm)
t5: Y offset (unit: µm)
t6: Axis rotation angle (unit: 0.000001°) When -180.000000 is specified, the matrix No. is 

not scanned.

(12) ERR (Reset Errors)

Clear the current error. 

(13) TRB (Error code acquisition)

Obtain all current error codes.

Example

When changing X offset of Layout No. 1 and Matrix No. 10 to 20.000 mm; Y offset to 
20.000 mm; Axis rotation angle to 0.000000°.
Computer -> Controller : MRW1, 1, 5, 10, 20000, 200000, 0

Matrix No.

The matrix No. indicates the scanning order of matrix, and sequence numbers 0 to 9999 
are assigned. When creating a matrix with SWDraw2, the matrix No. is different if the 
matrix is created with "Row priority" or "Column priority."

<Row priority>                                                       <Column priority>

X offset and Y offset of matrix are absolute coordinates from an origin (0, 0). 
The center of axis rotation angle is the lower left coordinates of a figure.

Computer -> Controller : ERR

Example

Emergency stop and layout command errors have occurred
Computer -> Controller : TRB

Controller -> Computer : 11, 22
When multiple errors have occurred, all error codes are returned, delimited by 
commas.
(Error codes are not sent in ascending order by error code number.)
If no error occurs, only STX, ETX, and checksum are returned.

�
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(14) WSR/WSW (Scanner warm-up execution)

Obtain (Read) the current status of scanner warm-up.
Also, executes scanner warm-up.

■ Read (WSR)
s0: Scanner warm-up status (0: Warm-up at a stop, 1: Warm-up in execution, 2: Cannot 

be executed due to warm-up at a stop)

■ Write (WSW)

t0: Number of warm-ups (Number of round-trip times of scanner) (10 times if shortened)

(15) WWWR00 (Power monitor data acquisition)

Obtain (Read) the power monitor data.

Example

When warm-up is in execution

Example

When executing 5 times of warm-up

Computer -> Controller : WWWR00t0t1

t0 Schedule No. 00 to 31 (YAG (SHG) laser welder)
0000 to 0255 (Fiber laser welder)

t1 Data No.
(Set 99 to obtain values of 
items shown at right delimited 
by commas at a time.)

01 Schedule No. of laser power monitor data
02 Lamp input power
03 Laser Energy
04 Number of laser power monitor 

waveforms
05 Flash pulse width

S
T
X

E
T
X

W
S
R

S
T
X

E
T
X

1
N
A
K

Controller

Check-
sumComputer

orCheck-
sum
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T
X

E
T
X

N
A
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W
S
W
5

A
C
K

Controller

Check-
sumComputer

or
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(16) WWWR95 (Power monitor count acquisition)

Obtain (Read) the power monitor count.

Controller -> Computer : s0

Setting of t1 Data range
s0 01 Schedule No. of laser 

power monitor data
00 to 31 (YAG (SHG) laser welder)
0000 to 0255 (Fiber laser welder)

02 Lamp input power 000 to 999 (×1%) (YAG (SHG) laser welder)
Fixed to 000 (Fiber laser welder)

03 Laser Energy 0000 to 9999 (×0.1J) (YAG laser elder)
0000 to 9999 (×0.01J) (YAG SHG laser elder)
000000 to 999999 (×0.01J) (Fiber laser welder)

04 Number of laser 
power monitor 
waveforms

000 to 108

05 Flash pulse width 000 to 100 (×0.1ms) (ML-2050A/2051A/2150A)
0000 to 1000 (×0.1ms) (YAG laser welder other 
than above)
0000 to 300 (×0.01ms) (YAG SHG laser welder)
0000 to 5000 (×0.1ms) (Fiber laser welder)

Example

When obtaining the laser energy (99.99 J) of the schedule No. 0001 on the fiber laser 
welder
Computer -> Controller : WWWR00000103

Controller -> Computer : 009999

Computer -> Controller : WWWR95t0t1

t0 Schedule No. 00 to 31 (YAG (SHG) laser welder)
0000 to 0255 (Fiber laser welder)

t1 Data No.
(Set 99 to obtain values of 
items shown at right delimited 
by commas at a time.)

01 Total number of outputs until the present
02 Number of outputs of appropriate energy
03 Average power of output laser light

Controller -> Computer : s0

Setting of t1 Data range
s0 01 Total number of 

outputs until the 
present (for 
flashlamp)

000000000 to 999999999

02 Number of outputs 
of appropriate 
energy

000000000 to 999999999

03 Average power of 
output laser light

0000 to 9999 (×0.1W) (YAG laser welder)
0000 to 9999 (×0.01W) (YAG SHG laser welder)
000000 to 999999 (×1W) (Fiber laser welder)

04 Total number of 
outputs for until the 
present (for 
wavelength conversion 
crystal)

000000000 to 999999999
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Example

When obtaining the number of outputs of appropriate energy (100 times) of the 
schedule No. 0001
Computer -> Controller : WWWR95000102

Controller -> Computer : 000000100
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1. Basic Specifications

* The connector at the cable connection portion, LASER CONTROL button and filter (with cover) are 
not included.

Chapter 7 Specifications

Item Specifications

Ambient temperature 5°C to 35°C (with no condensation or freeze)
Note: Contact us when using in ambient temperature below 5°C.

Ambient humidity 80% RH or lower (with no condensation or freeze)

Temperature during storage -10°C to 55°C (with no condensation or freeze)

Humidity during storage 80% RH or lower (with no condensation or freeze)

Vibration during transport (with 
packaged) 1.0 G or less (horizontal), 2.0 G or less (vertical)

Impact during transport (with packaged) 10.0 G or less (horizontal), 20.0 G or less (vertical)

Dust 8 mg/m3 or less

Electromagnetic 
compatibility 
standards

Immunity

Complied with the following:
IEC61000-4-2 (Electro-static immunity: Contact discharge±6kV, 
Aerial discharge±8kV)
IEC61000-4-3 (Radiated field: 10V/m 80-1000MHz)
IEC61000-4-4 (Fast transient burst noise: Power supply±2kV, 
Transmission line±1kV)
IEC61000-4-5 (Lightning surge: Power supply (L1-L2) ±1kV, 
Power supply (L1-E,L2-E) ±2kV)
IEC61000-4-6 (Conducted immunity: 10V/m 0.15-80MHz)
IEC61000-4-8 (Magnetic field immunity: 36A/m)
IEC61000-4-11 (Dips/Interrupts)

Emission
Complied with the following:
EN55011:2007+A2:2007 (Radiated disturbance)
EN55011:2007+A2:2007 (Conducted disturbance)

Power supply voltage Single-phase, 100 V AC to 240 V AC ±15% (50/60 Hz ±3%)

Power consumption Average: Approx. 45 W, Peak: Approx. 140 W

External dimensions* 360(W) mm × 420(D) mm × 122(H) mm

Mass Approx. 6.9 kg
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2. Components

Item Model No. Specifications Length Quantity

Scanner 
controller

GWM-STD/SHG AS1155495 - - 1

GWM-STD2-000 LP1201114 - - 1

Scanner 
head

GWM-STD LP1190959 1064 nm - 1 (× No. of 
branches)

GWM-SHG LP1190961 532 nm - 1 (× No. of 
branches)

GWM-STD2-000 LP1201182 1064 nm - 1

EXT. I/O (1)-LASER cable NSDJ-PP-JS-
37-10

Between Scanner controller 
and Laser welder, D-Sub 37 pin 10 m 1

EXT. I/O (2)-LASER cable NSDJ-PP-JS-
25-10

Between Scanner controller 
and Laser welder, D-Sub 25 pin 10 m 1

EXT. I/O (3)-LASER cable NSDJ-PP-JS-
9-10

Between Scanner controller 
and Laser welder, D-Sub 9 pin 10 m 1

RS-485 
cable

GWM-STD/SHG AS1202425 Between Scanner controller 
and Laser welder

10 m 1

GWM-STD2-000 AS1201223 10 m 1

Head 
control 
external 
cable

GWM-STD/SHG AS1202431 Between Scanner controller 
and Scanner head, High 
density D-Sub 44 pin

5 m 1 (× No. of 
branches)

GWM-STD2-000 AS1155387 5 m 1

Scanner 
cable

GWM-STD/SHG AS1201214 Between Scanner controller 
and Scanner head, Twinax 
cable 26 pin

5 m 1 (× No. of 
branches)

GWM-STD2-000 AS1201217 5 m 1

USB cable PNUC2-AB-
5M

Between Scanner controller 
and Computer 5 m 1

Power cable AS1201213

Ratings of 125 V AC, 7 A
Note: Be sure to use within its 

rating. Appropriate cable 
should be provided by 
customer when using 
with power supply 
voltages exceeding 125 V 
AC.

5 m 1
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3. Accessories

The model numbers of accessories are subject to change without notice. Depending on 
the part to be changed, the mounting screw shape may change and a necessary tool 
may be different. For the latest parts information, contact a nearest sales office.

Item Model No. Specifications Quantity

Operation manual for 
GWM series CD-ROM AS1155498 - 1

Operation manual for 
SWDraw2 CD-ROM AS1201118 - 1

PC software SWDraw2 AS1177027 - 1

Head shorting 
connector AS1164496

High density D-Sub 44 pin
Note: The same number of connectors as 

unused heads are required if not 
using any head I/F connector.

2
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4. Optional Items

Item Specifications

Computer

For computer specs,
Please check the instruction manual for the software SWDraw2 for Laser 
Scanning System for Welding.

Manual number: OM1201123
Reference: Appendix A

Laser welder

The following laser welders can be used.
[YAG laser welder]
• ML-2050A/2051A/2150A
• ML-2350A/2350AF/2351A/2351AF
• ML-2450A/2451A
• ML-2550A/2551A/2552A/2553C
• ML-2650B/2651B
[Fiber laser welder]
• ML-6700B/6810B
• ML-6040A
[YAG SHG laser welder]
• ML-8150A

Optical fiber Optical fiber should be selected to suit laser welder and laser schedules 
used.

CCD camera unit

A camera and video monitor can be combined to allow machining to be 
checked during operation. Contact us for details.
Item No.: 1011359 (for laser welders other than ML-6810B)
Item No.: 1173011 (for ML-6810B)
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1. GWM-STD/SHG

Chapter 8 Outline Drawing
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2. GWM-STD2-000
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Dimensions in mm



1. System Configuration Examples by Application

58

GWM-STD/SHG/STD2-000

1. System Configuration Examples by Application

Chapter 9 Typical Configurations

Application Laser unit Fiber Area Output limit Spot diameter

Microwelding
ML-2051A

SI 0.1
35

7J/7W
0.08

60 0.15
SI 0.2 60 0.30

ML-6040A SI 0.05 □94 - 0.1

Spot-welding ML-2351A
SI 0.3

35

50J/50W

0.30
60 0.56

SI 0.4 35 0.40
SI 0.6 35 0.60

High-output 
spot-welding

ML-2450A SI 0.3 35 70J/140W 0.48

ML-2552A
SI 0.2

35 20J/150W 0.32
60 20J/150W 0.60

SI 0.3 35 20J/250W 0.48
ML-2651B SI 0.3 35 80J/200W 0.48

High-output 
seam-welding

ML-6700B SI 0.05 □94 - 0.1
ML-6810B SI 0.1 □94 - 0.2
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2. High-Speed Welding System Configuration 
Examples

Specifications Components Type Quantity

Micro spot-welding system
Area : 35
Spot diameter : 0.2 max.

Laser unit ML-2051A-010-00-00 1
Fiber SI 0.1, 5 m 1

Scanner fθ lens: f80
Collimator lens: f100 1

Computer Windows 10 Pro 1

Spot-welding system
Area : 60
Spot diameter : 0.6 max.

Laser unit ML-2351A-010-00-00 1
Fiber SI 0.3, 5 m 1

Scanner fθ lens: f150
Collimator lens: f80 1

Computer Windows 10 Pro 1

High-output spot-welding system
Area : 35
Spot diameter : 0.6 max.
Pulse energy : 65 J

Laser unit ML-2651B-010-00-00 1
Fiber SI 0.3, 5 m 1

Scanner fθ lens: f80
Collimator lens: f50 1

Computer Windows 10 Pro 1

High-output seam-welding system
Area : □94
Spot diameter : 0.1 max. 
Pulse energy : 500 J

Laser unit ML-6700B-010-00-00 1
Fiber SI 0.05, 5 m 1

Scanner fθ lens: f163
Collimator lens: f80 1

Computer Windows 10 Pro 1
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1. Before Inspection and Parts Replacement

This section describes simple maintenance tasks that can be performed by users.

For optimal performance, we recommend performing annual inspections and 
comprehensive overhauls once every two years.
For more information, please contact us.

2. Parts Replacement

As user-serviceable parts wear with use, performance will decline, eventually 
requiring repairs or replacement.
Inspect the unit regularly, referring to the guidelines provided in the following table:

*1 The schedule means the maintenance time or expected life of the part, and is different from the 
warranty period.

*2 The service life will be shorter if the equipment is shut down for extended period.

Chapter 10 Inspection and Parts 
Replacement

Before performing any maintenance tasks, turn OFF the equipment and wait 
at least five minutes to stop the equipment safely.
Touching the equipment interior when it is on may result in electric shock.

•  Use our genuine maintenance parts.
•  For defect caused by non-genuine maintenance parts or use of non-

genuine maintenance parts, the repair is charged even if it is still within 
the maintenance contract period or the warranty period.

Component Model No. Schedule*1

(Recommended)
Maintenance

Lithium battery 
*2

CR2450/BK 3 years

Replace at end of service life
See "Chapter 10-3. Backup 
Lithium Battery Replacement" 
(page 61).

CAUTION

CAUTION
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3. Backup Lithium Battery Replacement

3.1. Lithium Battery

The scanner controller includes a lithium backup battery. If this battery is exhausted, 
settings in the memory will be lost when the power switch of the scanner controller is 
turned OFF. Purchase a new battery from us and replace the battery when either of 
the conditions below is met.

• Three years have passed since the battery was replaced
• Within one week after battery errors are displayed

3.2. Preparation

Have the following ready when replacing the lithium battery.

• New lithium battery
• Hex wrench
• Phillips screwdriver

3.3. Replacing the Lithium Battery

1 About thirty minutes before replacing the battery, turn ON the power switch of the 
scanner controller to activate the battery. This step is required to charge the internal 
power supply, which is used for data storage during battery replacement. This step 
may be omitted if the equipment has been in use for more than thirty minutes.

2 On the scanner controller, turn OFF the power switch.

 GWM-STD/SHG

3 Unscrew the screw connected 
to ground on side of the 
scanner controller.

4 Unscrew the four screws on 
bottom of the scanner 
controller on either side.

5 Remove the cover by pulling it 
towards you.

Ground screw (M3) x1

Screw (M3) x4 in total

Slide cover forward for removal
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3 Unscrew the screw connected to ground 
on side of the scanner controller.

4 Unscrew the four screws on bottom of 
the scanner controller on either side.

5 Remove the cover by pulling it towards 
you.

6 Remove the control board’s lithium 
battery.

7 Insert the new lithium battery. Confirm 
correct polarity before insertion.

8 Replace the cover.

Follow your local environmental 
regulations for battery disposal 
because Lithium Battery contains 
dangerous materials.

Screw x4

Screw x4 in total

Lift up the cover.

Lithium battery

Control board

�
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4. Memory Card Management

We recommend backing up the data on memory cards to your computer periodically in 
case of accidents.
Additionally, be sure to save a copy of the data before using the equipment for the first 
time.
When inserting the memory card, be careful not to break a pin of the memory card 
slot.
To back up data, you will need a compact flash reader or a compact flash adapter, 
which must be provided separately.

4.1. Backing Up Memory Cards

1 Connect the compact flash reader or adapter to a computer so that the computer 
recognizes the memory card.

For more information, refer to the documentation for the compact flash device.

2 Double-click the [My Computer] icon to confirm that the memory card is correctly 
recognized.

If the additional memory card drive is displayed, you are ready to start backing up the card.

If not, refer to the documentation for the compact flash product for more information.

3 The memory card drive structure is as 
follows:

•  SYSTEM
•  AUTORUN
•  Stsfile
•  feel

4 Select [Select All] from the [Edit] menu.

All file icons are highlighted.

5 Select [Copy] from the [Edit] menu.

6 Navigate to the target directory for 
storing a backup copy of the files.
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7 Select [Paste] from the [Edit] menu.

The screenshot at right shows an example when 
the memory card contents are copied to the folder 
“CFBackup” created on the desktop.

The files have now been backed up.

4.2. Restoring Data to Memory Cards

Data previously backed up can be restored to a memory card.

1 Connect the compact flash reader or adapter to a computer so that the computer 
recognizes the memory card.

For more information, refer to the documentation for the compact flash device.

2 Double-click the [My Computer] icon to confirm that the memory card is correctly 
recognized.

If the additional memory card drive is displayed, you are ready to start backing up the card.

If not, refer to the documentation for the compact flash product for more information.

3 Access the directory of the memory card drive.

4 Select [Select All] from the [Edit] menu.

All file icons are highlighted.

5 Press the <Delete> key.

6 Navigate to the directory of the backup copies.

7 Select [Select All] from the [Edit] menu.

All file icons are highlighted.

8 Select [Copy] from the [Edit] menu.

9 Navigate to the directory of the memory card drive.

10 Select [Paste] from the [Edit] menu.

Backed-up data has now been restored to the memory card.
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4.3. Checking Available Memory Card Space

If you encounter problems when transferring data from the computer, check the 
amount of free space left on the memory card.

1 Connect the compact flash reader or adapter to a computer so that the computer 
recognizes the memory card.

For more information, refer to the documentation for the compact flash device.

2 Double-click the [My Computer] icon to confirm that the memory card is correctly 
recognized.

If the additional memory card drive is displayed, you are ready to start backing up the card.

If not, refer to the documentation for the compact flash product for more information.

3 Right-click on the memory card drive 
icon and select [Properties].

At least 10% of the memory card space must be 
available or frequent errors may result.

In this case, use a higher-capacity memory card 
(sold separately).
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If a system error occurs, pressing the [RAS] button displays details of the error on the 
PC. For details of the [RAS] button, refer to the manual for SWDraw2.

Chapter 11 Error Messages

Error details Corrective action

1 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

2 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

3 Component not 
registered Component data is not registered. Register data.

4 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

5 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

6 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

7 Layout data not 
registered

Layout data is not registered.Register data. Select a layout number other 
than "0."

8 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

9 Scanning speed error Scanning speed setting error. Adjust scanning speed.

10 ACK timeout No ACK (operation complete) response from conveyor within time limit. 
Check the conveyor.

11 Layout command error Layout error. Restart the system and PC before sending the layout data.

12 Layout parameter error Layout error. Restart the system and PC before sending the layout data.

13 Insufficient layout 
command error Layout error. Restart the system and PC before sending the layout data.

14 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

15 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

16 Scanning area error Layout error. Reset the system and PC before sending the layout data.

17 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

18 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

19 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.
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20 Battery voltage low The system battery voltage is low. Replace the battery.

22 Emergency stop
An emergency stop signal was input. Close the external I/O control 
connector external emergency stop input. Or release the EMERGENCY 
STOP button on the system front or control panel.

60 to 
79 Controller error Controller error. Contact us if this error occurs even after turning on the 

power again.

83 Memory card error Memory card error. Contact us if this error occurs even after turning on the 
power again.

84 Memory card capacity 
exceeded The memory card is full. Either delete data or use a new memory card.

85 to 
96 Controller error Controller error. Contact us if this error occurs even after turning on the 

power again.

97 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

98 RAM registration 
memory exceeded Contact us if this message appears.

99 Component registration 
memory exceeded

Component registration exceeds the memory available, or the component 
cannot be registered. Re-register the component.

100 Layout registration 
memory exceeded

Layout file registration exceeds the memory available, or the layout file 
cannot be registered. Re-register the layout file.

110 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

111 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

112 Controller error Controller error. Contact us if this error occurs even after turning on the 
power again.

113 RS-485 Command Error An error occurred with RS-485 command. Confirm whether the right laser 
welder is connected.

114 RS-485 Communication 
Error

Can't communicate with the laser welder. Check the RS-485 cable is 
connected.

115 Memory Switch Error Memory switch error. Contact us if this message appears.

116 Welder Registration 
Error Welder registration error. Contact us if this message appears.

117 Scanner Connection 
Error

Scanner connection error. Confirm that the connection is performed 
correctly.

118 I/O Cable Connection 
Error

The EXT. I/O (1)-LASER cable between the scanner controller and the laser 
welder is disconnected. Confirm that the connection is performed correctly.

120 LED Defect:
Safety Shutter Open (1)

There is a problem with the Shutter alarm lamp. If the error persists after 
restarting, contact us.

121 LED Defect: LD(HV) On 
(1)

There is a problem with the LD(HV) alarm lamp. If the error persists after 
restarting, contact us.

122 THERMAL Fiber 
Interlocked (1)

Thermal Interlock of the scanner head is on. Please cool down the unit for a 
while.If the problem still exists after cooling, contact us.

Error details Corrective action
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123 Head Cover Open (1)
The head cover is detached. Attach the cover.
In addition, the short-circuit connector on the rear may be removed. Check 
the connector.

124 Scanner Monitor Unit 
Error (1)

An error is detected in the scanner monitor unit. Confirm that the cooling 
water flows in the scanner head correctly. If the error persists following 
these measures, contact us.

130 LED Defect:
Safety Shutter Open (2)

Thermal Interlock of the scanner head is on. Please cool down the unit for a 
while.If the problem still exists after cooling, contact us.

131 LED Defect: LD(HV) On 
(2)

There is a problem with the LD(HV) alarm lamp. If the error persists after 
restarting, contact us.

132 THERMAL Fiber 
Interlocked (2)

Thermal Interlock of the scanner head is on. Please cool down the unit for a 
while.If the problem still exists after cooling, contact us.

133 Head Cover Open (2)
The head cover is detached. Attach the cover.
In addition, the short-circuit connector on the rear may be removed. Check 
the connector.

134 Scanner Monitor Unit 
Error (2)

An error is detected in the scanner monitor unit. Confirm that the cooling 
water flows in the scanner head correctly. If the error persists following 
these measures, contact us.

140 LED Defect:
Safety Shutter Open (3)

There is a problem with the Shutter alarm lamp. If the error persists after 
restarting, contact us.

141 LED Defect: LD(HV) On 
(3)

There is a problem with the LD(HV) alarm lamp. If the error persists after 
restarting, contact us.

142 THERMAL Fiber 
Interlocked (3)

Thermal Interlock of the scanner head is on. Please cool down the unit for a 
while.If the problem still exists after cooling, contact us.

143 Head Cover Open (3)
The head cover is detached. Attach the cover.
In addition, the short-circuit connector on the rear may be removed. Check 
the connector.

144 Scanner Monitor Unit 
Error (3)

An error is detected in the scanner monitor unit. Confirm that the cooling 
water flows in the scanner head correctly. If the error persists following 
these measures, contact us.

194 Scanner Temp or Flow 
Error

About 30 minutes has passed since the LD (HV) is turned on with the 
scanner temperature or the flow warning. For the scanner with the monitor 
unit, check the flow rate (water or air).

198
Schedule number 
Switching error*1

The laser device schedule number cannot be switched.
Check that the EXT. I/O (1)-LASER cable between the scanner controller 
and laser device is connected correctly. If error recurs, consult us.

Error details Corrective action
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*1 This error is displayed only when the following schedule handshake function is selected.
The GWM scanner controller switches a schedule of the welder through the EXT. I/O (1)-LASER 
cable. The open-loop control is adopted for speeding up the schedule switching when [Handshaking] 
is set to OFF, but the check function by the handshake using the RS-485 cable is available by setting 
it to ON.

Handshake sequence (A broken line indicates operation when [Handshaking] is ON.)

* Compared with operation when [Handshaking] is OFF, about 100 ms of takt increases for each 
schedule switching for checking the response of a schedule number. Also, when the response of a 
schedule number cannot be confirmed for 1600 ms, the schedule number switching error occurs.

[At normal operations]

[At abnormal operations]
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About error code 200 and later

The error code 200 and later indicate errors occurred in the laser welder. For details, 
refer to the operation manual for the connected laser welder.

The error code displayed on the RAS screen of SWDraw2 is the laser welder’s error 
code plus the following number different according to model.

Laser welder’s error code + 200 ML-2050A/2051A/2150A/8150A

Laser welder’s error code + 300 ML-2350A/2350AF/2351A/2351AF/2450A/2451A/
2550A/2551A/2552A/2553C/2650B/2651B

Laser welder’s error code + 5000 ML-6040A

Laser welder’s error code + 6000 ML-6700B/6810B
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1. ML-2050A/2051A/2150A

(Supports program version V00-02L (issued March 2004) or later)

INITIAL screen memory switch settings
(Refer to "INITIAL Screen" in the laser welder Operation Manual.)
SW1-1 ON : HV-ON not activated on AUTO-START.
SW2-6 ON : Sets transfer speed to 19,200 bps.
SW3-7 ON : Switch on when using with Laser Scanning System for Welding.

CPU circuit board ME-1925 / ME-3023 / ME-3080 DIP switch settings
(Refer to "Changing Laser Start Signal/Schedule Signal Acceptance Time" in the 
laser welder Operation Manual.)
Set laser start delay to 1 ms.
Set DIP switch 4 (SW4) Nos. 1 and 2 to ON.

Chapter 12 Laser Welder Settings
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2. ML-2350A/2350AF/2351A/2351AF/2450A/2451A/
2550A/2551A/2552A/2553C

(Supports program version V00-02H (issued March 2004) or later)

INITIAL screen memory switch settings
(Refer to "INITIAL Screen" in the laser welder Operation Manual.)
SWITCH1-1 ON: HV-ON not activated on AUTO-START.
SWITCH2-6 ON: Sets transfer speed to 19,200 bps.
SWITCH3-2 and 3 ON, and 4 OFF:Laser start delay 1 ms
SWITCH3-7 ON: Switch on when using with Laser Scanning System for 

Welding.

3. ML-2650B/2651B

(Supports program version V00-02H (issued March 2004) or later)

MEMORY SWITCH screen memory switch settings
(Refer to "MEMORY SWITCH Screen" in the laser welder Operation Manual.)
SWITCH1-1 ON: LD(HV)-ON not activated on AUTO-START.
SWITCH2-6 ON: Sets transfer speed to 19,200 bps.
SWITCH3-2 and 3 ON, and 4 OFF:Laser start delay 1 ms
SWITCH3-7 ON: Switch on when using with Laser Scanning System for 

Welding.
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4. ML-6700B/6810B/6040A

INITIALIZE screen PREFERENCE settings
(Refer to "PREFERENCE Screen" in the laser welder Operation Manual.)
BAUD RATE 57600: Sets transfer speed to 57,600 bps.
 or
BAUD RATE 19200: Sets transfer speed to 19,200 bps.

LD AUTO START NOT:  LD-ON not activated on AUTO-START.
LASER START DELAY 1ms: Laser start delay 1 ms

INITIALIZE screen memory switch settings
(Refer to "INITIALIZE Screen" in the laser welder Operation Manual.)
SWITCH3-7 ON: Switch on when using with Laser Scanning System for 

Welding.
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5. ML-8150A

MEMORY SWITCH screen memory switch settings
(Refer to "MEMORY SWITCH Screen" in the laser welder Operation Manual.)
SWITCH1-1 ON: HV-ON not activated on AUTO-START.
SWITCH2-6 ON: Sets transfer speed to 19,200 bps.
SWITCH3-7 ON: Switch on when using with Laser Scanning System for 

Welding.
 

CPU circuit board ME-1925 / ME-3023 / ME-3080 DIP switch settings
(Refer to "Changing Laser Start Signal/Schedule Signal Acceptance Time" in the 
laser welder Operation Manual.)
Set laser start delay to 1 ms.
Set DIP switch 4 (SW4) Nos. 1 and 2 to ON, and No. 3 to OFF.

When the transfer speed is set to 
19,200 bps, ”OFF” is displayed on 
SWITCH 2-7.


	About This Documentation
	1. Organization
	2. Note
	3. Symbols Used in this Manual

	Chapter 1
	Special Precautions
	1. Safety Precautions
	2. Operating Precautions
	3. For Disposal

	Chapter 2
	Features
	Chapter 3
	System Configuration
	1. Overall Configuration
	2. Name and Functions of Each Section
	2.1. Front
	2.2. Rear


	Chapter 4
	Installation
	1. Unpacking
	1.1. Lifting and Transporting Container
	1.2. Checking the Contents of Container

	2. Installation
	2.1. Installation Requirements
	2.2. Connections
	2.3. Ground Connection


	Chapter 5
	Starting/Stopping the Equipment
	1. Starting the Equipment
	2. Stopping the Equipment

	Chapter 6
	Interface
	1. Pin Layout
	1.1. External Input and Output (EXT. I/O (1)-USER)
	1.1.1. Input signals
	1.1.2. Output signals

	1.2. External Input and Output (EXT. I/O (2)-USER)
	1.2.1. Input signals
	1.2.2. Output signals

	1.3. External Input and Output (EXT. I/O (3)-USER)
	1.3.1. Input signals
	1.3.2. Output signals

	1.4. Extended External Input and Output (EXT. I/O (4)-USER)
	1.4.1. Input signals
	1.4.2. Output signals

	1.5. Carriage Control Input and Output (AXIS. I/O)
	1.5.1. Input signals
	1.5.2. Output signals


	2. Example Connection
	2.1. External Input and Output (EXT. I/O (1)-USER, EXT. I/O (2)-USER)
	2.1.1. When external inputs are contacts
	2.1.2. When external inputs are NPN transistors
	2.1.3. When external inputs are PNP transistors
	2.1.4. When external power source is supplied
	2.1.5. Example connection of external output signals

	2.2. External Input and Output (EXT. I/O (3)-USER)
	2.3. Extended External Input and Output (EXT. I/O (4)-USER)
	2.3.1. When connected to 24 V DC source output PLC
	2.3.2. When using contact signal
	2.3.3. When using open collector signal


	3. Timing
	3.1. During Normal Operations (Single Delivery)
	3.2. During Normal Operations (2-timesharing Delivery)
	3.3. During Data Errors (Errors from Unregistered Layouts)

	4. RS-232C Communication Functions
	4.1. Overview
	4.2. Interface
	4.3. Instructions for RS-232C Communications
	4.4. Communications Protocol
	4.5. Commands
	4.5.1. Command Details



	Chapter 7
	Specifications
	1. Basic Specifications
	2. Components
	3. Accessories
	4. Optional Items

	Chapter 8
	Outline Drawing
	1. GWM-STD/SHG
	2. GWM-STD2-000

	Chapter 9
	Typical Configurations
	1. System Configuration Examples by Application
	2. High-Speed Welding System Configuration Examples

	Chapter 10
	Inspection and Parts Replacement
	1. Before Inspection and Parts Replacement
	2. Parts Replacement
	3. Backup Lithium Battery Replacement
	3.1. Lithium Battery
	3.2. Preparation
	3.3. Replacing the Lithium Battery

	4. Memory Card Management
	4.1. Backing Up Memory Cards
	4.2. Restoring Data to Memory Cards
	4.3. Checking Available Memory Card Space


	Chapter 11
	Error Messages
	Chapter 12
	Laser Welder Settings
	1. ML-2050A/2051A/2150A
	2. ML-2350A/2350AF/2351A/2351AF/2450A/2451A/ 2550A/2551A/2552A/2553C
	3. ML-2650B/2651B
	4. ML-6700B/6810B/6040A
	5. ML-8150A




